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Introduction

This Setup Guide describes how to setup and use a CoDeSys development environment with a
Grayhill 3Dxx Display product. The CoDeSys development environment is an implementation of
the IEC-61131-3 open international standard for programming programmable logic controllers.
The CoDeSys IDE runs on a Windows 7/8/10 PC and communicates with a Grayhill 3Dxx
Display product via Ethernet. This document also describes how to use Grayhill specific
software for the CoDeSys environment that provides access to the special hardware features of
the 3Dxx Display products.

This document will not explain how to write a CoDeSys program. It is assumed that the user is

already very familiar with programming in a CoDeSys environment. This document only
discusses elements that are unique to using a Grayhill 3Dxx Display product with a CoDeSys

IDE.

Supported Hardware Products

The Grayhill CoDeSys development environment can currently support these Grayhill 3Dxx
Color Display Models:

e 3D50 Five Inch Color Display (800 x 480 pixels and up to two CAN buses)
e 3D70 Seven Inch Color Display (800 x 480 pixels and up to two CAN buses)

The table below summarizes the key features of each of these models. Note that the features of a

specific product may vary depending on the purchased hardware configuration.

Model Number 3D50 3D70

Display Size (inches) 5 7

Pixel Count (w x h) 800 x 480 800 x 480

Touch Screen Input Yes Yes

Real Time Clock Yes Yes

CAN Ports 2 2

Camera Inputs 2 3

USB ports 1 (maintenance 1 (maintenance
only) only)

RS232 1 (maintenance 1 (maintenance
only) only)

Built-in Ethernet 0 1

Digital Input (dedicated) | 1 4

Digital Output 1 4

(dedicated)

Digital Input / Output 3 0

Analog Input 0 2

Audio Output No 1 channel

Buzzer No Yes
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Recommended Equipment from Grayhill

If using Model 3D50 Five Inch Display:
3D50DEV-200 3D50 Development Kit which includes:

©)

O O O O O O O O O O

3D50VT-200 Display

3D50 Mounting Frame

3D50 Development stand

3D50 Breakout board

3D50 18-pin DT cable to connect 3D50 to Breakout Board

USB to CAN adapter to provide CAN port for PC

DB9 cable to connect CAN adapter port to 3D50 Breakout Board
12VDC Universal Power Supply

DB9 cable to connect PC serial port to 3D50 Breakout Board *
USB to Ethernet adapter to provide Ethernet port on 3D50 *
Ethernet cable to connect 3D50 Ethernet adapter to PC network *
* These items are only provided on kits shipped after January 1, 2016

If using Model 3D70 Seven Inch Display:
3D70DEV-200 3D70 Development Kit which includes:

(@]

O O O O 0O O O O O

3D70VT-200 Display

3D70 Mounting Frame

Four M5 x 0.8 screws and washers

3D70 Development stand with 3D70 Breakout board

Two 18-pin DT cables to connect 3D70 to Breakout Board

USB to CAN adapter to provide CAN port for PC

DB9 cable to connect CAN adapter port to 3D70 Breakout Board
12VvDC Universal Power Supply

DB9 cable to connect PC serial port to 3D70 Breakout Board
Ethernet cable to connect 3D70 Ethernet port to PC network

Other Recommended Equipment (for all displays)

o

o

An Ethernet port connected to a DHCP server that can be connected to the 3Dxx
Display. This port should be on the same network as the development PC.
PC running Windows 7/8/10 (32/64 Bit) with the following features:

= 3 GB RAM (minimum)

= 250 GB available hard drive space (minimum)

= Ethernet port

= RS232 Port

Software Required

1. CoDeSys Development System (i.e., CoDeSys IDE) installation software for PC.
This software can be downloaded free directly from CoDeSys at
https://www.codesys.com/ (International) or https://us.store.codesys.com/ (North

America).
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The CoDeSys software interfaces for Grayhill 3Dxx display products have been verified
using version 3.5 SP10 Patch 4 of the CoDeSys IDE.

2. Grayhill 3Dxx Display CoDeSys support package (Grayhill3DxxDisplay.package) which
contains the support libraries specific to the Grayhill 3Dxx devices.
This software can be downloaded from the Grayhill website at:
http://www.grayhill.com/codesys/

3. A PC program to access the serial port console of the 3Dxx Display. (If all goes well, the
serial port interface to access the Linux console may not be needed). The 3Dxx Display
console operates at 115200 baud, 8 data bits, no parity, one stop bit, and no flow control.

CoDeSys Runtime Software

The Grayhill 3Dxx display products are supplied with 2 versions of the CoDeSys runtime
software installed:

e Version 3.5.9.20

e Version 3.5.10.40

The 3Dxx displays are configured with Version 3.5.9.20 as the ‘active’ version, which is the
same version that has been provided on the 3Dxx displays shipped to date.

The 3Dxx displays also contain script files for configuring the active version:
e selectcodesysSP10.sh — Version 3.5.10.40
e selectcodesysSP9.sh — Version 3.5.9.20

Running the selected script file will re-configure the active CoDeSys runtime for the display.
So for example, to activate the 3.5.10.40 version, call “selectcodesysSP10.sh”. No arguments
need to be provided to the script.

The benefit to using the newer CoDeSys runtime Version 3.5.10.40 is that it solves an issue seen
in Version 3.5.9.20 where on startup, a blank screen would be displayed briefly prior to the
actual application being displayed. This undesired flashing of blank screen is eliminated with
Version 3.5.10.40.

Installation Overview

This is a brief overview of the installation steps for the CoDeSys development environment for a
Grayhill 3Dxx Display.

e First connect the 3Dxx Development Kit hardware to the PC being used. This includes
connecting the Ethernet port and serial port interfaces. (If all goes well, the serial port
interface to access the Linux console may not be needed). For the 3D50 Display this
procedure is described in detail in the document “3D50-Development-Kit-Quick-Start-
Guide.pdf” and for the model 3D70 Display it is described in the document “3D70-
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Development-Kit-Quick-Start-Guide.pdf”. These documents are available for download
on the Grayhill website at https://www.grayhill.com/3d-series-displays.

e Second, the CoDeSys IDE is installed on the development PC.

e Next the file “Grayhill3DxxDisplay.package” will be installed on the development PC to
provide access to the 3Dxx Display unique support libraries and devices.

e Finally instructions are provided on how to upload the demonstration program from the
3Dxx Display to the development PC. The 3D50 model demonstration project shows how
to use touch screen “buttons”, how to use touch screen swipes, how to set the 3DxX
backlight level, how to access system information such as file system free space, how to
operate the 3Dxx video inputs, how to access the digital 1/O’s, and how to access and set
the real time clock. The 3D70 model demonstration project shows all of the previous
items listed for the 3D50, plus it also shows how to use the internal buzzer, audio output,
and analog input features.

Installation of CoDeSys IDE on PC

The installation process described here assumes version 3.5 SP10 of the CoDeSys IDE. If using
a newer version, the process may look slightly different.
e Download the CoDeSys Development System installation software.
e Unzip the files in the .zip file to a folder on the development PC.
e Double click on the file “Setup_CODESYSV35SP10Patch4.exe” to install CoDeSys on
development PC. If this or similar error appears, just click “OK” button:

CODESYS V3.5 SP9 Patch 2 (US) - Ins ]

'18] ID_INFO_LANGID_US

e During installation, need to accept license agreement and defaults can be used for all
other options.

e Run the CoDeSys program (there should be an icon for it on the desktop).

e After the CoDeSys IDE has completed its initialization, use Windows file explorer to
navigate to the folder “C:\ProgramData\AP\PlugInCaches”. If there is a file in the folder
called “CODESYS-614171C9.cache”, then either delete it or rename it in order to
prevent problems with following package installation step.

e On CoDeSys menu line, select “Tools > Package Manager...”
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e On the “Package Manager” screen, click on the “Install...” button and navigate to the file
“Grayhill3DxxDisplay.package” that was downloaded previously. Click “Open” when
proper file is selected. The following dialog should appear:

& Installation - Choose Setup Type @
Grayhill2DxzcDisplaySupport [1.3.0.0] _
Please selectthe typeof setup youwould liketo perform. -:’T

Complete setup
All package components will beinstalled.

$ @ Typical setup

The most commonly used package components will beinstalled.

Customized setup

Full control over which package components are installed.
Recommended for advanced users,

s

Cancel Mext =

e Select “Typical Setup” and click on the “Next > button.
e After the package installs, click on the “Finish” button.
e C(Click on the “Close” button to exit the “Package Manager” dialog.
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e Itisa good idea to click on menu item “Tools = Options - Load and Save” and activate
the auto save features as shown here:

CFC Editor A

vl Composer

i@ Dedaration editor [T Create backup files

ﬁ Device description download -

m Device editar V¥ automatically save every I 10 3, minutes
] FED, LD and IL editor IV Save before build

B~ FOT Options
@ International Settings

m Libraries

m Library download

(= | Load and Save At startup: IShDW Start Page j
{ PLCopenXML News page: Ihttp:,.",."'n"n"a\'.cudesys.cumfstarmage

ﬁ Proxy Settings

{5 Refactoring Homepage: Ihttp:,.",."'A"n".-\'.cudesys.cum,"

SFC editor
L_=l SmartCoding
= Store

= Syntax Highlighting |-

Text editor

@ Visualization
ST NV T hal Advanced settings...
bl 1D

x|

e CoDeSys development environment is now configured to operate with the Grayhill 3Dxx
Display.
PLEASE NOTE:
The 3Dxx Display products are shipped with the flash file system
set to read-only mode. This helps prevent file system corruption
and provides faster and more consistent boot up times. In order to
develop CoDeSys programs with a 3Dxx Display, it will be
necessary to enable writing to the flash file system. Refer to
Appendix B: Setting 3Dxx Flash File System R/W Mode for
information on how to do this. Also the CoDeSys launch script
installed by the USB update stick contains a line to enable writing
to the flash file system.
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Uploading Demo Program from 3Dxx Display

e Power up the 3Dxx Display and make sure that its Ethernet port is connected to the
development PC.

e On the CoDeSys IDE on the development PC, click on the on menu item “File > New
Project”.

e Select “Project” under “Categories”, select “Standard Project” under “Templates”, and
select a suitable file location as shown here:

‘ New Project ﬁl

Categories: Templates:

1 Projects '

Empty project  Standard Standard
project project w...

A project containing one device, one application, and an empty implementation for PLC_PRG

MName: |3D5EIdem|:||
Location: IC:'n,l_lsers'n,admin'n,Du:u:l_lments'n,mdesys'|,3D5IZIdem|:| j |

oK Cancel |
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e [f using a 3D50 Display then select the “Grayhill 3D50 Display” device or if using a
3D70 display then select the “Grayhill 3D70 Display” device as shown here:

Standard Project

You are about to create a new standard project. This wizard will create the following
| | objects within this project:
.

- One programmable device as specified below
- A program PLC_PRG in the language specified below
- & cyclic task which calls PLC_PRG

- A reference to the newest version of the Standard library currently installed.

Device:

x|

PLC PRG in: |Structured Text (5T)

o]

[

Cancel |

e Click on menu item “File = Source upload...” and when this screen appears, select the

device that corresponds to the 3Dxx Display as shown here:

Select Device

Select the network path to the controller:

= -.ﬁ'-,-o Gateway-1

[ |ghiims (00741 |

Device Name:
ghiimxg

Device Address:
0074

Target Version:
3.5.8.30

Target Vendor:
Grayhill Inc.

Target ID:
1678 0001

Target Name:
Grayhill
ARMCortex/Linux

Target Type:
4096

Add gateway...
Add device. ..

Delete

Scan netw

a

=

Wink

i |

oK ] l Cancel

Note that the “Device Address:” is the hexadecimal representation of the last byte of the
3Dxx Display’s IP address. If the 3Dxx Display does not appear, refer to section Solving
CoDeSys IDE to Display Connection Problems for help in correcting problem.
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e On this dialog screen select an appropriate place to upload the demo project and then
click on the “Extract” button:

o

Extract Project Archive

Locations:
Extract into the same folder where the archive is located
(@) Extractinto the following folder:

C:Wsers\admin'\DocumentsUploadTest

Contents:

[l

+ Download information files

[ Eutract ][ Cancel ]

-

e When asked about saving the existing project, it is referring to the new project that was
created in the beginning of this process to select the Grayhill 3Dxx Display device. It is
OK to not save this project and delete its files.

e When the extraction is done, the source code for the demonstration program loaded on
the 3Dxx Display will be available for review and editing.
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Solving CoDeSys IDE to Display Connection Problems

The CoDeSys IDE running on the development PC connects to the Grayhill 3Dxx Display
via Ethernet. In order for this linkage to work, the IP address assigned to the Grayhill 3Dxx
Display must be placed in proper place in the “CODESY SControl.cfg” file located in the
folder “/home/CODESY S/CODESY SControl” on the 3Dxx Display. Normally the script file
“cds_setup.sh” which is run before starting the CoDeSys runtime package on the 3Dxx
Display does this automatically. However, if the IP address was not correct when CoDeSys is
launched on the 3Dxx Display, then the connection to the development PC will not be
possible. If this occurs, follow these steps to update the IP address:

e Use serial port on development PC to access the Linux console port on the 3Dxx Display.
The 3Dxx Display uses 115200 baud, 8 data bits, no parity, one stop bit, and no flow
control.

e On the Linux console enter the command “/home/killapp” to terminate the current
CoDeSys runtime task.

e Use the “ifconfig” command to verify that the IP address for the 3Dxx Display has been
properly assigned.

e Enter the command “/etc/init.d/launchcodesys” to restart CoDeSys.
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Interfacing 3Dxx Hardware via CoDeSys

The 3Dxx Display contains the following custom component interfaces:

e LCD

e LCD Backlight

e Video Input Interface

e CAN Interface

e Digital I/O Interface

e Real Time Clock with battery backup

e Analog Input (Model 3D70 only)

e Buzzer and Audio Output (Model 3D70 only)

This section explains how to access the functionality of these components via CoDeSys
programming.

LCD

The Grayhill 3Dxx Series Display uses a 16 bit per pixel LCD screen. The pixel dimensions of
various 3Dxx Display products are shown in the section Supported Hardware Products. The demo
program supplied for the 3D50 display is in portrait mode (wider pixel dimension is in vertical
direction). The demo program supplied for the 3D70 display frame buffer is in landscape mode
(wider pixel dimension is in horizontal direction).

The frame buffer can be rotated between landscape and portrait orientation by modifying the
setup file “/home/CODESY S/CODESY SControl/cds_setp.sh” located on the 3Dxx Display. For
example, to switch from portrait mode to landscape mode just place a “#” (start of comment)
before the “export...” on the line after “Portrait mode” and remove the “#” (start of comment)
before the “export...” on the line after “Landscape mode” as shown in this portion of the
“cds_setup.sh” file:

# Portrait mode
# export QWS COMMANDLINE PARAM="-gqws -display transformed:rot270:LinuxFb:/dev/fbl"

# Landscape mode

export QWS COMMANDLINE PARAM="-qws -display LinuxFb:/dev/fbl"
In order for the above changes to take effect, stop the codesyscontrol task on the 3Dxx Display
by running the /home/killapp script. Then restart the codesyscontrol task by entering the
command /etc/init.d/launchcodesys.
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A landscape mode CoDeSys project can be created as follows:
e Inthe CoDeSys IDE click on menu item File >New Project... and select “Project” under
“Categories” and select “Standard Project” under “Templates” as shown here:

‘ Hew Project El
Categories: Templates:
{1 Libraries ;'@ : ﬂ
3 | =
1 Projects ‘ [E
Empty project  Standard Standard
project project w...

A project containing one device, one application, and an empty implementation for PLC_PRG

Mame: |3D5I]demnPN|
Location: IC:\,Users‘n,admin‘n,Dm:umEnts‘n,mdesys‘n,SDEDdemnPN j |

oK Cancel |
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e Select the appropriate Grayhill Display device (3D50 or 3D70) when asked as shown
here:

Standard Project x|

You are about to create a new standard project. This wizard will create the following
= objects within this project:

§=

- One programmable device as specified below

- A program PLC_PRG in the language specified below

- & cyclic task which calls PLC_PRG

- A reference to the newest version of the Standard library currently installed.

Device:

PLC_PRG in: |Structured Text (ST) ﬂ

| 0K I Cancel |

e Right click on the “Application” item on the “Devices” tree and select “Add Object >
Visualization...”. On the next “Add Visualization” screen, click the “Add” button.
e Right click on the “Visualization” item on the “Devices” tree and select “Properties”.
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e On the “Visualization” tab of the “Properties...” screen, set the visualization size to the
appropriate landscape size dimensions as show in this example:

Properties - Visualization [ Device: PLC Logic: ﬂ

Common I Access control  Visualization |Euild I

UseVisualization as:

% Visualization
i~ Dialog

{~ Numpad/ Keypad/ dialogforinput configuration

{~ Use automatic detected visualization size
T Include background image

{%¥ Usespecified visualization size

Visualization size:
(Width: 300 Height: IqBD

[" Internal

oK Cancel Apply

e Create visualization objects and program code in the project.
e Download project to 3Dxx Display and run it.

LCD Backlight

The LCD Backlight setting is a value between 0 and 100 inclusive. There is a special Grayhill
library component to set this backlight level. Just add the “CmpGrayhill3DxxBackLite” library
using the “Library Manager”. This will provide a function called CmpGrayhill3DxxBackL.ite
that accepts an integer argument to set the backlight level. This function can be called
continuously without much execution overhead because it remembers the last backlight setting
and does not reprogram the backlight unless the new value differs from the previous setting.

Video Input Interface

The Grayhill 3Dxx Display device can support multiple video inputs as defined in the section -
Supported Hardware Products. There is a special Grayhill library component to setup and control
the video inputs and how they are displayed. Use the “Library Manager” to add the library
“CmpGrayhill3DxxVideo”. This will also include another library component that lists the
channels available for the current 3Dxx Display being used.

These video support libraries provide two functions:
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e VideolnputSetup — This function configures the video input parameters.
e VideoToShow — This function controls which video channel (if any) will be displayed.

Both of these functions remember all previous settings and will only reprogram the video
hardware if a parameter has changed. Some parameters such as brightness, contrast, and
saturation can be changed without turning off the video display. Changes to other parameters
such as display position and size, require stopping the video display while the parameters are
adjusted. These functions handle all of this logic automatically.

Notes:

e The display position coordinates are always specified in landscape mode; however, there
is a rotation parameter that can adjust the video display to work correctly with any
orientation.

e The “TopLeftX” and “Width” parameters must always be divisible by four. The video
support functions will automatically enforce this rule by zeroing out the last two bits of
these parameters and will return an appropriate return code if this was required.

e The video inputs are 640 x 480 which results in a 4:3 aspect ratio. When setting the video
image size on the display, if this aspect ratio is not maintained, there will be image
distortion.

e When the camera LayeringCode selection is set to Foreground mode, the video image
will cover any graphics drawn on the display where the video image appears. When the
video is deactivated, the covered graphics will reappear.

e When the video LayeringCode selection is set to Background mode, then the ColorKey
parameter is used. The allowable ColorKey selections and their associated red, green, and
blue values are shown in the table below. Note that the transparent code in the first byte is
set to FF (opaque). Any graphics pixels drawn in the area where the video image appears
that match the Color Code corresponding to the selected ColorKey will allow the video
image to show through. Pixels of any other color will be opaque and will cover the video
image in that area. This makes it possible to draw graphics over a video image.

Color Code

(DWORD)
16#FF000000 COLOR_CODE_BLACK
16#FFFF0000 COLOR_CODE_RED
16#FFO0FF00 COLOR_CODE_GREEN
16#FFO000FF COLOR_CODE BLUE
16#FFFFFFOO0 COLOR_CODE_YELLOW
16#FFOOFFFF | COLOR_CODE_CYAN
16#FFFFOOFF COLOR_CODE_MAGENTA
16#FFFFFFFF | COLOR_CODE_WHITE

ColorKey
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CAN Interface

The 3Dxx Display supports CAN interfaces as shown in the section Supported Hardware
Products. These CAN interfaces can be accessed as raw CAN devices as shown in the included
demonstration program. They can also be accessed using the standard CoDeSys J1939 or
CANopen support libraries.

Diqgital I/O Interface

The Model 3D50 Display and Model 3D70 Display each have four digital inputs and four digital
outputs, but they are configured differently and these differences will be explained. Both devices
access these digital inputs and outputs via CoDeSys 1/O mapping.

On the 3D50 Five Inch Display Pin 4 on its connector is a dedicated input only pin. Pins 6, 7,
and 8 are 1/0O pins that can be used to output a signal or input a signal. In order for these pins to
function as an input pin, the corresponding output must be set to low. All Model 3D50 inputs
have a 51.1Kohm pull down.

On the Model 3D70 Seven Inch Display each of the four inputs are dedicated and so operate
independently of any output pins; however, each input pin can be configured to have a 10Kohm
pull-up, a 10Kohm pull-down, or neither.

On both models, an input must be less than 2.2 volts to be detected as low and must be greater
than 2.7 volts to be detected as high.

On both models, when an output pin is set low it is left floating (except for Pins 6, 7, and 8 on a
Model 3D50 which have the 51.1Kohm pull down). When an output pin is set high, it is
connected to Vbatt and may source up to 200 mA.

The following table summarizes all of the digital 1/O pins for both models

Model 3D50 Pins Model 3D70 Pins

Input 1 (Pin 4) Input 1 (Pin 4 Connector A)
Input 2 and Output 2 (Pin 6) Input 2 (Pin 8 Connector B)
Input 3 and Output 3 (Pin 7) Input 3 (Pin 9 Connector B)
Input 4 and Output 4 (Pin 8) Input 4 (Pin 10 Connector B)
Output 1 (Pin 5) Output 1 (Pin11 Connector B)
Output 2 and Input 2 (Pin 6) Output 2 (Pin12 Connector B)
Output 3 and Input 3 (Pin 7) Output 3 (Pin13 Connector B)
Output 4 and Input 4 (Pin 8) Output 4 (Pin14 Connector B)

Note that Pin 4 on the 3Dxx Color Display connector is a dedicated input only pin and Pin 5 is a
dedicated output only pin. Pins 6, 7, and 8 are 1/O pins that can be used to output a signal or
input a signal. In order for these pins to function as an input pin, the corresponding output must
be set to low. When in the low state the pin is not driven low and if it is a shared 1/O pin the pin
may be used as an input. When a pin is set high it is connected to Vbatt.
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The Model 3D50 digital 1/0 can be accessed through CoDeSys by adding the device
GH3D50GPIO. This device provides three sets of bits as shown here:

GH3D50GPIO IjO Mapping Find Filter Show all <
Channel | Address | Type | Description

sEnz EH3DS0INputs °ID0  DWORD Read input pins (inputs < 2.2 volts return 0, inputs > 2.7 volts return 1)
#Find %eIX0.0 BOOL Reads Pin 4 input

Information ins %I¥0.1 BOOL  Reads Pin 6 input (Pin 6 output must be set FALSE to use Pin 6 as input)
Fin7 2LIX0.2  BOOL Reads Pin 7 input (Pin 7 output must be set FALSE to use Pin 7 as input)
#Find %IX0.3 BOOL Reads Pin & input (Fin 8 output must be set FALSE to use Pin 8 as input)
GH3D500utputs 20D0  DWORD  Set Qutput Pins (0 sets pin inactive, 1 sets pin to Vbatt with 200ma max source)
#in5 %R0X0.0 BOOL Controls Pin 5 output
FinG %e0X0.1 BOOL Contrals Pin & output (Must be set FALSE to use Fin & as input)
FinT 2L0X0.2 BOOL Controls Pin 7 output (Must be set FALSE to use Pin 7 as input)
#Fing %e(QX0.3 BOOL Controls Pin 8 output (Must be set FALSE to use Pin 8 as input)
GH3D500utp. .. 2101 DWORD  Read back current state of output pins
#inSRE %I¥4.0 BOOL  Read back Pin 5 output
FincRE %IX4.1 BOOL Read back Pin & output
#inTRE %I¥4.2 BOOL  Read badk Pin 7 output
#inSRE %IX4.3 BOOL  Read back Pin 8 output

The first set of four pins is used to read the inputs. The second set is used to set the outputs. The
third set of pins can be used to monitor the current output pin settings. This can be useful if
outputs need to be maintained in that same state when a program restarts.

The Model 3D70 digital 1/0 can be accessed through CoDeSys by adding the device
GH3D70GPIO. This device provides three sets of 1/0 bits and one set of configuration bytes as
shown here:

GH3D70GPIO [jO Mapping Find Filter Show all -
Channel | Address Type | Description

sis GH3D70Inputs %LIB0 BYTE Read input pins {inputs < 2.2 volts return 0, inputs > 2.7 volts return 1)
PinA4 %eIX0.0  BOOL Reads Pin A4 input

Information PinB3 %I¥0.1  BOOL Reads Pin BS input
PinBS %elX0,2  BOOL Reads Pin BY input
PinB 10 %I¥0.3  BOOL Reads Pin B10 input
PinA4Config %L0B0 USINT(16#0..16%2)  Set Input Pin A4 Config (0: float, 1: 10K pull down, 2: 10K pull up)
PinB&Config %QB1 USINT(16#0..16%2)  Set Input Pin B8 Config (0: float, 1 10K pull down, 2: 10K pull up)
PinBSConfig QB2 USINT(16#0..16#2)  Set Input Pin B9 Config (0: float, 1: 10K pull down, 2: 10K pull up)
PinB 10Config %083 USINT(16#0..16%2)  Set Input Pin B10 Config (0: float, 1: 10K pull down, 2: 10K pull up)
GH3D700utputs QB4 BYTE Set Output Pins {0 sets pin inactive, 1 sets pin to Vbatt with 200ma max source)
PinB11 %Q¥4.0  BOOL Controls Pin B11 output
FinB12 %eQx4.1  BOOL Controls Pin B12 output
PinB13 eQX4.2  BOOL Controls Pin B13 output
PinB 14 %Q¥4.3 BOOL Controls Pin B14 output
GH3DFOOUtputRB %IE 1 BYTE Read back current state of output pins
PinB11RE %el¥1.0  BOOL Read back Pin B11 output
PinB12RE %el¥1.1  BOOL Read back Pin B12 output
FinB13RE %elX1.2  BOOL Read back Pin B13 output
PinE 14RE %l¥l.3 BOOL Read back Pin B14 output

The first set of four pins is used to read the inputs. The second set of bytes is used to configure
the input pull-up or pull-down resistor for each input. The third set of bits is used to set the
outputs. The fourth set of pins can be used to monitor the current output pin settings. This can be
useful if outputs need to be maintained in that same state when a program restarts.
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Real Time Clock with battery backup

Both Grayhill displays (3D50 and 3D70) can be ordered with a battery backup for the real time
clock. Any of the standard CoDeSys widgets can be used to set the real time clock and the new
setting will be preserved during power loss. No other special action is needed.

Analog Inputs (Model 3D70 only)

The Grayhill Model 3D70 Display has two analog inputs. Analog Input 1 is connected to Pin 4 on
Connector B and Analog Input 2 is connected to Pin 5 on Connector B. The Analog Inputs can be used
to read resistance, voltage, or current with respect to the analog return pin (pin 7 on Connector B). There
is a special Grayhill library component to configure and read the analog inputs. Use the “Library
Manager” to add the library “CmpGrayhill3D70Analog”. This library component includes two
functions, one to configure the input mode of an analog input channel and the other is used to
read the input of an analog input channel.

Buzzer and Audio Output (Model 3D70 only)

The Grayhill Model 3D70 Display has an internal buzzer and an audio output. The audio output
has the ability to play an mp3 audio file and send the audio output to a monaural line out (pins 1,
AUDIO OUT, and 2, AUDIO RET, on the B connector). There is a special Grayhill library
component to control both of these features. Use the “Library Manager” to add the library
“CmpGrayhill3D70Audio”. This library component includes two functions, one to turn the
internal buzzer on or off or the sound it for a specified amount of time; and the other function
can start or stop the playing of an mp3 file.

In order to play an mp3 audio file it must be placed in this directory on the target display:
“/home/CODESYS/CODESYS/Plclogic”

A file can be placed here using the CoDeSys development environment by right-clicking on the
“Device (Grayhill 3D70 Display)” item in the “Devices” tab and then selecting “Add Object
—>External file...”.
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Saving CoDeSys Variables

In order for CoDeSys to save its variables through a power cycle of the 3Dxx display, the
CoDeSys runtime (codesyscontrol) must be shut down prior to powering off. This is
accomplished with the use of the Grayhill switched input driver and a simple Grayhill
background application (pswmonitor). The application is started by the CoDeSys launch script.

The application registers with the switched input driver to receive a notification event when the
switched input is turned off. This allows for shutdown activities to be performed prior to the
display actually powering off.

When the notification event is received, the application runs a script file (shutdown.sh) which
'kills' the CoDeSys runtime. The “kill> command causes the CoDeSys runtime to first save its
variables before terminating. The Linux OS is then able to shut down and the display power off.

Please note that CoDeSys variables are not saved if unswitched (battery) power is removed prior
to or rather than switched power.
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Appendix A: 3Dxx Display Linux Passwords

e There is no password for “root” user on the 3Dxx Display Linux system

Appendix B: Setting 3Dxx Flash File System R/W Mode

e To immediately set the 3Dxx Display file system to read-write mode enter this console
command:
mount —-o remount,rw /

e The above command can also be found in the shell script /nome/writeablefs
e The above command only remains in effect until the next reboot.
e To have the 3Dxx Display file system set to read-write mode on boot-up, edit the file

[etc/init.d/rc-once and add the above command to the end of this file just before the final
“exit” command like this:

case "$1" in
start)
do_start >&2

*)
echo "Usage: $0 {start}" >&2
exit 1

esac
mount -o remount,rw /

exit O

e To leave the 3Dxx Display file system set to read-only mode on boot-up, edit the file
[etc/init.d/rc-once and remove the “mount -o remount,rw /” line near the end of the
file (or comment it out by putting a “#” in column one of that line).

PLEASE NOTE:
It is not recommended to leave the 3Dxx Display flash file system
in read-write mode on fielded units because this may result in file
system corruption and slower or inconsistent boot-up times.
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